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MODULE SIX: Analysing and Presenting 
your Model 
Module 6 consists of 5 videos: 

1. Assumptions Documentation Methods 
2. Business Case Scenario Analysis 
3. Charting on two axes and Chart Types 
4. Business Case Dynamic Charting 
5. Presentation of Model Output 

 
Log into your online course and download the Excel templates on each video page. Follow along with 
the video demonstration, and save your model.  Note that the Excel models in Module Two are not 
required uploads for this course, however, you are welcome to submit them if you’d like us to check 
that you’re on the right track.   
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Video 6.1: Assumptions Documentation Methods 
Recommended Reading: See the section on “Methods and Tools of Assumptions Documentation” in 
Chapter 3, page 59 of Using Excel for Business Analysis 

From a technical perspective there are a number of ways in Excel of documenting what those 
assumptions are. Let's go through some of those different methods.  

 

Open the file “Assumptions Documentation Methods” as shown in the video.   

In-Cell Comments 

“Red Triangle” Comments 

1. Select cell B3, right-hand click on it, and select Insert Comment  
2. Type in the source of where the data came from, and then click away from the comment 
3. When the mouse hovers over the cell, the comment appears 

 
These types of comments do look a little messy, they don’t print very well and aren’t visible unless 
the mouse hovers over the cell. 

Data Validation Comments 

1. Select cell B5 
2. Go to the Data Tab on the Ribbon, and select Data Validation from the Data Tools group 

http://www.plumsolutions.com.au/using-excel-business-analysis
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3. Select the second tab called “Input Message” and enter your comments, including a title to 
appear at the top of the message, and press OK. [This works in the same way for Mac Users] 

4. Click away from the cell, and when you select cell B5 again, the message appears 
 

These types of data validation comments are more discreet and are most appropriate for 
instructional types of messages, or reminders for the user. 

Footnoting 

It is possible to go into Page Setup and put footnotes into the Header/Footer section of the page but 
this method is rarely used in financial modelling because it is only visible in Print Preview or once the 
sheet has been printed.  It is more common to create number references in a cell, and change the 
format of the cell to italic and superscript, hence manually creating a footnote in the model. 

1. Go to cell H4 and type in a 1.  Right-hand click, select Format Cells and on the Font tab, select 
superscript and italic as shown. 

2. Add the 1. to the beginning of the text in cell A6 such that the text now says 1. nb: growth rate 
does not change over time 

 
Hyperlinks 

If your source data exists as a webpage, or if you want to create a source reference to another file, 
then hyperlinks are a useful method of assumptions documentation.  If it’s a webpage, simply copy 
the URL and paste it directly into a cell. 

To reference other parts of the model, or other files, it is possible to insert hyperlinks using the 
Hyperlink Icon on the Insert Tab in the Ribbon. 

Hard-coded Text 

Whilst good financial modelling practice does not recommend hard-coding numbers, hard-coding 
text assumptions is fine.   

For example, in cell A6 we have hard-coded the assumption in by typing “1. nb: growth rate does not 
change over time” into the cell.  This text is static, and will not change when the inputs in the model 
change. 

Linked, Dynamic Text 

If your assumptions documentation contain numbers, however, which already exist in the model 
then it is good practice to string text and numbers together in the documentation. 

1. Select cell A7 and enter the hard-coded text “Number of customers starts at 15,065 in 2016” 
2. Now make this into a formula by putting an equals sign at the beginning and inverted commas 

around the text like this: =“Number of customers starts at 15,065 in 2016” 
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3. Replace the value 15,065 by linking it to the value in cell B5 using the ampersand like this: 
=“Number of customers starts at “&B5&” in 2016” 

4. Add in or edit spaces if necessary 
5. Next, replace the 2016 with the value in cell B4 like this =“Number of customers starts at 

“&B5&” in ”&B4 
6. Test that the dynamic documentation is working by changing one of the values in the cells, for 

example change the value in cell B5 from 15,065 to 15,059, and check that your sentence 
shown in cell A7 also changes accordingly 

 
We can apply this technique also to our footnoting.  

7. Go back to cell A6 and change your text to a formula so that it looks like this: =“nb: growth 
rate does not change over time” 

8. We can now dynamically link this to our footnote number in cell C3 
9. Change the formula in cell A6 to =H4&“nb: growth rate does not change over time” 
10. You may choose to add a “. “ (dot and then a space) at the beginning of the text part of the 

formula as shown in the video if you wish so that the result shown in cell A6 is 1. Nb: growth 
rate does not change over time” 

11. Test this by changing cell H4 from a 1 to a 2 and you’ll notice the footnote number change as 
well 

12. Because this footnote relates to the growth rate, we think it would be more appropriate to 
move it closer to the rate shown in cell B3.  We can easily move the footnote reference by 
cutting and pasting it from cell H4 to cell C3 (remember that we need to cut and paste, not 
copy and paste in order for the links to work correctly) 

In summary, assumptions documentation is absolutely critical in financial modelling best 
practice. You need to state explicitly where the numbers came from and if there's anything that 
could be misinterpreted based on your inputs or your assumptions then it needs to be clearly 
documented.  As discussed in this section, there are many different methods and Excel tools that 
can be used to document the assumptions in your financial model. 
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Video 6.2: Business Case Scenario Analysis 
Recommended Reading: See chapter 11 on “Stress-Testing, Scenarios, and Sensitivity Analysis in 
Financial Modelling” on Page 342 of Using Excel for Business Analysis.  

1. Go to the “Assumptions” page in your Business Case model, and in cells E3:G6, enter the 
following table. 

 

 

2. These cells will now become the hard-coded, input variables, so they should be formatted in 
blue font, or changed to use the input style. 

3. Now go to the “P&L” page, and in the scenario cell B3, create a Data Validation in-cell drop-
down box which contains the words “Best Case, 
Base Case, Worst Case.”   

4. To do this, select “Data Validation” from the 
“Data” tab in the “Data Tools” group.   

5. In the “Allow” box, select ‘List’ 
6. In the “Source” box, you can type the values 

directly into the list field, but it would be better practice to create a named range for cells 
E4:E6 on the “Assumptions” page called “Cases”.  In the field list on the data validation 
dialogue box, you can type in “=cases” as shown below.  If you decide to type directly into 
the data validation box, make sure you spell the words “Best case”, “Base Case” and “Worst 
Case” the same way you did in on the “Assumptions” page. 
 

See page 213 of “Using Excel for 
Business Analysis” if you need to 

review how to create drop-downs. 

http://www.plumsolutions.com.au/using-excel-business-analysis
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7. Click “OK” and you have a drop-down box we can use to select the scenarios. 
8. Name cell B3 “Scenario”. 
9. Go back to the “Assumptions” page, and change the hard-coded assumptions for Takeup 

and Churn in cells C11 and C13 to live formulas which will change as the user selects a 
different scenario. 
 
There are several options, and the formula in cell C11 will be: 

1. IF =IF(scenario=G7,H7,IF(scenario=G8,H8,H9)) 
2. SUMIF =SUMIF(cases,scenario,H7:H9) 
3. VLOOKUP =VLOOKUP(scenario,$G$6:$I$9,2,0) 

 
Any of these is fine. A VLOOKUP is a popular option, but make sure you’re not planning to enter 
or delete any columns! Now do the same for churn. 
 
10. Change the formatting of these cells to black font, as they will no longer be input variables. 
11. Go back to the “P&L” page and test the drop-down box and make sure the numbers are 

changing. 
 
Take a look at the numbers. We’re almost there! 
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Video 6.3: Charting on two axes and Chart Types 
Recommended Reading: See the section on “Charting with Two Different Axes and Chart Types” in 
Chapter 12, Page 394 of Using Excel for Business Analysis. Below is an extract from this chapter: 
 
Creating a chart on two separate axes, one on either side and on two different chart types is a great 
way of displaying the output of a financial model. How to build one can be a bit tricky, especially if you 
are using an older version of Excel.  Let’s take a break from our Business Case for a moment, and learn 
how to do one if you haven’t built one before.  Then we can go back and insert one into our financial 
model. 

Combo Charts 

One of the best ways of analysing the output of your model is to plot two different variables on the 
same chart, so that we can understand trends and look for correlations in the data. Sometimes the 
only way to spot a trend or an anomaly in the model is to look at it graphically. For example, how 
does our overall revenue compare to head count? Surely as revenue increases so should head count, 
and if it doesn't we need to understand why. What if we compare regions and their number of units 
sold and profit? Surely the regions with the highest number of units sold should be the most 
profitable? This may not necessarily be the case. Let's take a look at some data, and plot the number 
of units sold and the profits using two different chart types on two axes.  Note that in Excel 2013/16 
the Combo Chart has been introduced as a standard chart type, so the instructions differ somewhat 
between versions. 

If we have the data shown in the figure below, we can create a chart to compare units sold and 
profits. The easiest way to select the ranges is to highlight the data in columns A, B, and D by holding 
down the Control key, as shown below. 

 

Selecting Non-consecutive Ranges by Holding Down the Control Key 

Creating a Combo Chart in Excel 2013 

1. Select Recommended Charts from the Insert tab on the Ribbon. The Insert Chart dialog box 
will appear.   

2. Select the All Charts tab, and select Combo which can be found at the bottom of the dialog 
box as shown below 

http://www.plumsolutions.com.au/using-excel-business-analysis
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3. Click on Secondary Axis for one of Series Names, which will move it to the other axis, and 
press OK. 

4. Insert a title, and axis label from the Chart Elements option which appears when you click on 
the chart. 

 

Insert Chart Dialog Box in Excel 2013 

Your completed chart should look something like this: 

 

Completed Combo Chart 
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Creating a Combo Chart in Previous Versions of Excel 

In previous versions of Excel (namely 2007 or 2010), creating a combo chart requires several more 
steps.   

1. Hold down the control key to highlight the non-consecutive ranges as shown above 

2. Select the 2-D line from the Insert tab on the ribbon. In Excel for Mac 2011, select the 2-D line 
from the Chart tab on the ribbon.  

The chart so far will look something like this: 

 

Preliminary Line Chart 

This chart looks quite nonsensical because we are plotting two different types of units: number of 
units sold and profit (in dollars). 

The first thing we need to do is move the units sold to a new y-axis on the right- hand side. 

1. Select one of the series by clicking on it. Make sure the entire series has been selected. 
2. Right-click and go to Format Data Series. 
3. On the Series Options tab, click on Secondary Axis instead of Primary Axis. See Figure 12.28. 
4. This will create a new axis on the right-hand side. Note that this can also be done on the Layout 

tab (or the Format tab in Excel for Mac 2011) by clicking on Format Selection. 

Insert the axis labels to make your chart clearer. 
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Format Data Series, Secondary Axis 

Choose Primary Vertical Axis Title and Secondary Vertical 
Axis Title from the Axis Titles on the Layout tab in the 
ribbon. 

This will look better as a combination of a column and line 
graph, so let's change the Profit series to a column graph.  

1. Select the Profit series 
2. Right-click and select Change Series Type 
3. Choose a column chart 
 
Insert a title by selecting Chart Title from the Layout 

tab. 

 

Tip: These charts can be a little 
confusing if you try to put too much 
in, so keep it simple by sticking to 
only two series. Make sure that the 
axes are formatted correctly if 
currency symbols are appropriate. 
Leave the legend, which will make it 
clearer which section of the chart 
refers to which series. 
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Video 6.4: Business Case Dynamic Charting 
Recommended Reading: See the section on “Creating a Dynamic Chart” in Chapter 12, Page 402 of 
Using Excel for Business Analysis.  
 
Now that we know how to create a combo chart, let’s look at how to create one in our model.  
Choose two different units of measurement to display on the chart.  In the video we’ve chosen to 
chart acquired number of customers versus cash flow but if you choose to depict something else, 
that’s absolutely fine.  Choose something that is insightful and interesting, and tells us something 
visually about this business case. 

Add a Combo Chart to our Business Case  

1. As shown in the previous section, select your data including the headings, and dates.  Hold 
down the control key to select non-consecutive ranges. 

2. Select combo chart (or follow the steps in the previous section if you are using Excel 2010 or 
earlier) and show one series as a line, and the other as a column 

3. Change the title in cell A1 to a dynamically changing title using the formula: ="Business Case 
for Pet Insurance Product - "&scenario 

4. Check that the title changes as you change the drop-down box 
5. Add a title to your chart if there is not one there already.  Select the chart title, go to the 

formula bar, press the equals sign and click on A1.  This will add the title to your chart. 
6. Test that this works by changing the drop-down, and not only will the title in cell A1 change, 

but the title of the chart will change as well 
7. We’re done!  Your model should now look something like this: 

 

http://www.plumsolutions.com.au/using-excel-business-analysis
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Video 6.5: Presentation of Model Output 
Recommended Reading: See the section on “Presenting Model Output” in Chapter 12, Page 367 of 
Using Excel for Business Analysis. Below is an extract from this chapter. 
Also see the blog article: Tips for Preparing an Oral Presentation for Model Results which also 
contains an extract from the book. 
 

Now that we have finished our business case, let's go through and think about how we are going to 
present this to our manager’s tomorrow morning.  We're the modeller, the person who has built this 
financial model so they want to hear from us. We are going to get up in front of the committee meeting 
or the managers tomorrow morning and take them through the model. 

Once a model has been built, we then need to display its results clearly and concisely to get your 
message across, whether via a written report or oral presentation.  The output and presentation of 
the results is just as important as the rest of the model building process, because there is no point in 
having fantastically built model which none of decision-makers know about!  This final stage of the 
model building process is sometimes not given as much focus by many modellers, particularly those 
whose skills are often more analytical than visual. 

Preparing an Oral Presentation for Model Results 

Many analysts and modellers would agree that public speaking is not their favourite part of the job 
and whilst it might be fun to imagine your senior management in their underwear, it might be more 
helpful to be prepared, and follow these basic tips. 

As the person who knows the model best, financial modellers are often requested to communicate 
the results of the financial model as a formal presentation to the board or senior management. 
Understandably, many detail-orientated analysts often find that it is quite a challenge to distill their 
20-megabyte financial model that has taken weeks to build into a 10-minute presentation! 

Although most senior management may not be interested in seeing the model itself, they might like 
to see live and changing scenarios. If the model is built correctly, you'll be able make a single change 
to the input assumptions and the audience will be able to see the effects of these changing scenarios 
in real time. Make sure that you test all possible inputs in advance—nothing looks less professional 
than a #REF! error during a live sensitivity analysis. 

Not all presentations require you to use PowerPoint, and it’s not always appropriate, but in this kind 
of environment, where it is necessary to convey lots of information, having the summary tables or 
charts on a slide behind you while you are speaking will be helpful. It can also help to take the focus 
off you if you are a little nervous. 

Follow these basic rules of presentations: 

• Only display one key message per slide. Don't crowd it or try to convey too much at once. 
• Give them a more detailed report to look through, but what you show on the screen should 

be a very concise summary of this report. 

http://www.plumsolutions.com.au/using-excel-business-analysis
http://www.plumsolutions.com.au/articles/tips-preparing-oral-presentation-model-results


FINANCIAL MODELLING IN EXCEL (INTERMEDIATE) – MODULE 6 – ANALYSING AND PRESENTING YOUR MODEL 

 

© Plum Solutions Pty Ltd Page 16  www.plumsolutions.com.au 

 

• Make sure the font is big enough and clear on a data projector. Test it in advanced if you 
can—sometimes colours look great on a monitor, but look washed out when projected on 
the wall. 

• If you are showing the model itself on the screen, increase the zoom in Excel so that your 
audience can see the numbers. Test this in advance, and remember you'll only be able to 
show a small portion of the screen in this way. 

• Use charts and graphics to display your message. Generally the output from a model will be 
numerical, and charts are a great way of showing this. Research also shows that audience 
attention and retention of information increases significantly when graphics are used 
instead of pure text in presentations. 

Most importantly, be prepared for questions regarding the output, inputs, assumptions, or workings 
of the model. Make sure that you can defend the assumptions that have been used, or the way 
something has been calculated. If you are not comfortable with some of the assumptions, say so up 
front. The model output is only as good as the assumptions that have gone into it, so you need to 
make sure that the audience accepts the key assumptions before they will accept the model results. 

If you have the opportunity, spend some time with the key audience members in advance and walk 
them through the assumptions and methodology of the model. They might have some questions or 
comments that you have not anticipated, and it will give you a chance to make changes or prepare 
your answers to likely questions in advance. 
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Summarising and Displaying Model Results 

If you have a 10-minute slot during which you need to convey the high-level output of the model, 
you probably need about four slides. If we have put together a business case for a new product, for 
example, outputs for a typical financial model, may include: 

1. A summary of projected cash flows or profitability. You won't be able to fit more than 
about five years onto a PowerPoint slide, so if you need to show 20 years, just show Years 1, 
5, 10, 15, and 20, for example. 

2. Key assumptions. Use your judgement here to choose which assumptions are important. 
Select the ones that either impact the model the most, or you are most certain of. 

3. Scenarios analysis. On a slide you'll probably comfortably be able to fit 4175 scenarios so 
choose wisely. At minimum, display a best-case, base-case, and worst- case scenario. See 
“Scenarios and Sensitivity Analysis in a Business Case” in Chapter 11 for more detail on how 
to create these. 

4. Results of sensitivity testing. Show the results of tweaking a single assumption. For 
example, if we were to get our customer take-up amount wrong by 1 percent, this will cause 
a $500,000 change to the NPV—and this is something the audience needs to be aware of! 

If you have longer than 10 minutes, you might be able to show the model itself if the presentation is 
more of a workshop than a formal presentation. In either case, you should be able to give each 
person a hard-copy summary report of the first few pages of the model with more detailed numbers 
than you have been able to include in the PowerPoint presentation. If the model has been well 
written, each page will form the back up data and source information for the model, and can be 
printed or distributed if the recipient of the summary results requests further information. 

 



FINANCIAL MODELLING IN EXCEL (INTERMEDIATE) – MODULE 6 – ANALYSING AND PRESENTING YOUR MODEL 

 

© Plum Solutions Pty Ltd Page 18  www.plumsolutions.com.au 

 

 



FINANCIAL MODELLING IN EXCEL (INTERMEDIATE) – MODULE 6 – ANALYSING AND PRESENTING YOUR MODEL 

 

© Plum Solutions Pty Ltd Page 19  www.plumsolutions.com.au 

 

 



FINANCIAL MODELLING IN EXCEL (INTERMEDIATE) – MODULE 6 – ANALYSING AND PRESENTING YOUR MODEL 

 

© Plum Solutions Pty Ltd Page 20  www.plumsolutions.com.au 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Important Notice: These course materials are protected by copyright.  They are provided to students 
of Plum Solutions Online Training courses in soft PDF format and so may be printed for study 
purposes by the licensed student, but may not be copied, redistributed, posted to a website or 
reproduced in any way.   


